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Using this 
template  

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 
 Hidden 
guidance  

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 
Inserting new 
headings  

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 
Inserting new 
tables  

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

 
Numbering 
paragraphs  

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  

 
 

Initial assessment report  
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1.1  Introduction and background 

1.1.1 Background 

In May 2016 CH2M were commissioned by the Environment Agency, on behalf of Bradford 
Metropolitan District Council (MDC), to undertake Yorkshire Area Initial Assessments providing 
guidance on measures to reduce flood risk and potential funding availability. This report covers 
Old Main Street in Bingley. 

1.1.2 Description of Location 

Old Main Street is a road in the town of Bingley within the Bradford Metropolitan District. This 
road is close to the left bank of the River Aire and immediately upstream of Ireland Bridge. The 
study area incorporates Old Main Street and the surrounding area close to the River Aire 
including both banks upstream of Ireland Bridge. This area experienced severe flooding during 
December 2015. The site area is shown in Figure 1. 

According to the Index of Multiple Deprivation (IMD), the area is amongst the 40 to 50% least 
deprived neighbourhoods in the country.  

 

Figure 1: Old Main Street site location 
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1.1.3 Description of Watercourses and Geology 

The River Aire is a major river in Yorkshire flowing from Malham in the Yorkshire Dales, 
through the urban areas of Bradford and Leeds, before joining the River Ouse at Airmyn. The 
Aire is approximately 71 miles in length from its source to its confluence. 

The Upper Aire around Bradford is heavily urbanised and the floodplain is constrained by 
development. There are a number of tributaries within this area that respond rapidly to rainfall. 
There is also a large number of structures such as bridges in this area.  

1.1.4 History of Flooding 

The properties within the study area have been flooded several times in recent years. During 
the 2015 Boxing Day event properties were flooded when high river levels in the River Aire 
caused the river to overtop its banks. This area was also flooded from the river in 2000 and 
2012 during large events on the River Aire. 

The Boxing Day 2015 flood incident was the largest flood event recorded across the Upper 
Aire. The return period of this event was estimated to be between 80 and 100 years (1.25%-
1% AEP) at Kildwick in the Upper Aire and was greater further downstream with a return 
period of 200 years at Armley. 

1.1.5 Summary of Modelling Analysis 

In 2008 hydraulic and hydrological modelling of the Upper River Aire was completed by JBA to 
support the development of the Flood Risk Management Strategy. For this study the River Aire 
was modelled from High Hill Weir upstream of Gargrave to Fleet Weir downstream of Leeds 
and included Ireland Bridge. The Upper River Aire model is a 1D hydrodynamic ISIS model 
containing 1922 nodes. 

This study aimed to define flood risk within this area and identify potential flood risk 
management options. This informed the Flood Risk Management Strategy for the Upper Aire. 
The Flood Risk Management strategy recommended local flood risk management schemes, 
where there was justification, and identified a number of sites that should be progressed. 
Bingley/Ireland Bridge was not identified as a priority site in this report. 
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1.1.6 Drivers, Constraints, Opportunities 

The study area falls under the Aire Catchment Flood Management Plane (CFMP)1, and is 
covered by sub-area 3 Worth and Aire. The designated policy for the area at risk is Policy 
Option 5: Areas of moderate to high flood risk where we can generally take further action to 
reduce flood risk. 

The following drivers, constraints and opportunities have been identified within the study area.  

Political Drivers  Summary Description 

Catchment Flood Management Plan Aire Catchment Flood Management Plan 2010 

Catchment Flood Management Policy 

Policy 5 – Areas of moderate to high flood risk where we 

can generally take further action to reduce flood risk. 

Economic Drivers   Summary Description 

Funding Time Constraints 

Must be obtained within 6 year programme of capital 

investment 

Technological Drivers  Summary Description 

Improved Public Safety Via reduced flood risk 

Environmental Constraints  Summary Description 

Special Area of Conservation (SAC) South Pennine Moors 1.7km northeast of study area 

Sites of Specific Scientific Interest (SSSI) South Pennine Moors 1.7km northeast of study area 

Ancient Woodland 

Blakey Wood 0.1 kilometre to the south west from the 

site 

Conservation Area 

The entire study area is within the Bingley Conservation 

Area 

Tree Preservation Order 

There are some TPOs within the study area along the 

watercourse. All trees within the conservation area are 

also protected. Any work affecting these trees will 

require permission from the council prior to work taking 

place. 

Listed Buildings 

There are 12 listed buildings within the study area 

including Ireland Bridge 

Historical Park & Gardens Registered Parks 0.5km to the southwest of the site 

World Heritage Site 

The Saltaire World Heritage site is approximately 4km 

East from the study area. 

Refer to Appendix B for the full list of constraints that were considered. 

                                                
 
1 Aire Catchment Flood Management Plan (2010) https://www.gov.uk/government/publications/river-aire-
catchment-flood-management-plan 
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1.2 Problem and objectives 

1.2.1 Problem 

The site is at risk of fluvial flooding due to its proximity to the River Aire. 16 residential 
properties and 4 commercial properties are thought to be at risk from a 1-in-25 (4%) AEP flood 
incident. 

Work is currently being undertaken by the Environment Agency to determine the standard of 
protection provided by the existing river bank. 

Properties are also at risk of surface water flooding due to the steep slopes toward the river. 
Areas on both banks of the river have been identified as at risk of surface water flooding. 
There was significant flow observed down Altar Lane during Boxing Day 2015 causing flooding 
to properties to the south of Ireland Bridge. 

This report will identify potential solutions to the flooding issues and determine if there is scope 
for a flood scheme.   

1.2.2 Objectives 

The primary objective of this initial assessment is to undertake an initial appraisal to identify 
the flood risk issues and viable solutions for the affected properties and to identify any other 
potential flood risk management measures which are consistent with the current CFMP policy. 

The purpose of this report is to lay the groundwork and, where applicable, provide a business 
case for future appraisal. The report aims to achieve the following: 

• Confirm the need for a project; 

• Identify the issues and Political, Environmental, Societal, Technological, 
Legislative and Economic (PESTLE) drivers and opportunities related to the 
need; 

• Identify the options to address the need and problem; 

• Demonstrate that viable options exist based upon the available information; 

• Provide sufficient information to allow the packaging and optimisation of 
packages of future appraisal, design and construction packages; 

• Provide sufficient information for the appraisal scope to be prepared; 

• Make an assessment on the deliverability of the project; 

• Provide a basis/starting point for discussion with communities and partner 
organisations for use in the development of potential schemes and 
negotiations regarding funding contributions. 

1.3 Benefits 

In this area the primary benefit associated with a reduction in flood risk would be the reduction 
in economic damages to properties. This in turn would reduce disruption to local transport, 
businesses, schools and other infrastructure. 

The properties at risk consist of residential properties with some commercial properties such 
as shops and public houses. There are no significant public buildings within the study area. 
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Social benefits relate primarily to a reduction in stress, health effects (including risk to life) and 
loss of memorabilia for those at risk. 

An appraisal period of 100 years is assumed, over which the current Standard of Protection of 
existing assets is expected to decrease as a result of climate change. 

1.4 Options 

A long list of options has been compiled for the study area and is summarised in the table on 
the following page. The table shows the range of options considered and the reasoning for or 
against them being taken forward to the shortlist of options to be assessed.  
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Category Long List 
Option Description 

Take Forward 
for 

assessment? 
Reasoning / Notes / Past Study Reference 

Do nothing Do nothing All operational and maintenance 
activities cease 

Yes Required to support development of business case and 
benefit cost ratios. 

Do minimum Do Minimum Continue with current operational 
and maintenance activities.  

Yes Required to support development of business case and 
incremental b/c ratio. 

Non-structural 
(by EA) 

Improved flood 
warning 

Enhanced flood warning to allow 
residents to prepare plus appropriate 
implementation of flood action plans 

No Not funded via the capital programme.  
A Flood warning system is already in place for Bingley. 
During the 2015 Boxing Day event it was reported that 
these warnings were received after the onset of 
flooding to some properties. 
The Flood warnings for the area have been updated 
following the Boxing Day flooding. 

Non-structural 
(by EA) 

Flood action 
plans 

Improved direction of reactionary 
flood defence measures 

No The study area is already within a Flood Warning and 
Flood Alert area operated by the Environment Agency. 

Property level 
protection 

Property level 
protection 

Protection to individual properties 
(e.g. via air brick covers, door guards 
etc).  

Yes This may be viable given the high risk and relatively 
small number of properties at risk. There may be 
additional challenges implementing this due to the 
Bingley Conservation Area and the numerous listed 
buildings at risk 
This would not have been effective in flooding of the 
depths experienced in December 2015. 
This option may need to be considered in combination 
with other options. 

Operational 
(by Others) 

Improve 
operation/design  

Improve operation/design of assets 
not owned by the EA 

No No assets contributing to risk have been identified. 

Urban 
drainage 

Improve urban 
drainage. 

Improved surface water drainage 
system. 

No There is some surface water risk in the area particularly 
on the right bank of the river. This is a less significant 
risk than that from fluvial flooding and no solution has 
been identified for this assessment. 
This should be considered in any future appraisals. 
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Category Long List 
Option Description 

Take Forward 
for 

assessment? 
Reasoning / Notes / Past Study Reference 

Structural Earth bunds Flood bunds No There is not sufficient space available for this option. 

Structural Flood walls Flood walls Yes Construction of a flood wall along the river banks would 
reduce the risk of flooding from the river. This could be 
constructed on both river banks but would have most 
benefit on the left bank where the standard of protection 
is thought to be lower and more properties are at risk. 
The existing third party walls along the river could be 
replaced with a flood defence. 
Walls would be sheet piling with cladding to fit with local 
surroundings. There is limited space available and the 
wall would need to be along the riverbank. 

Structural Temporary 
defences 

Demountable flood walls, flood gates 
etc. 

No There is not thought to be sufficient warning time prior 
to a flood incident to deploy temporary defences within 
the study area. 

Structural Conveyance Channel deepening or widening No There is no available route or space for this option. 
The EA currently undertakes gravel removal from the 
channel at this location to maintain conveyance. 

Structural Conveyance Supplementary bypass channel(s), 
tunnels or floodway 

No No suitable locations for a bypass channel have been 
identified. 

Structural Conveyance Pinch point improvements – Ireland 
Bridge Weir 

No The weir upstream of Ireland Bridge could be removed. 
This would reduce water levels and reduce the potential 
for debris to collect here during a flood event and hence 
reduce risk. 
This is a high cost option and is not thought to produce 
a significant reduction in flood risk so has not been 
taken forward for assessment 

Structural Conveyance Pinch point improvements – Ireland 
Bridge 

No Ireland Bridge could be modified to reduce the 
obstruction posed by this bridge and the potential for 
the bridge to collect debris. 
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Category Long List 
Option Description 

Take Forward 
for 

assessment? 
Reasoning / Notes / Past Study Reference 

This bridge is a listed structure and would be 
challenging to modify. This option is not thought to 
reduce flood risk to a suitable extent to justify this 
modification. 
This option has not been taken forward for assessment. 

Flood storage 
area  

Online Use of active structures and re-
profiling to store water online.  

Yes The Upper Aire SFRA considered 2 online storage 
areas at Keighley Holden Park and Marley Bridge. 
These are upstream of Old Main Street and would 
reduce flood levels in the study area. 
These areas are being investigated for their benefits to 
Leeds City Centre as part of phase 2 of the Leeds FAS. 
This storage would also have benefits across the River 
Aire including the properties at risk at Old Main Street. 

Flood storage 
area 

Offline Gravity or pumping to offline storage 
area 

No No offline storage sites have been identified. 
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1.4.1 Shortlisted Options Description 
 
On-line Storage on River Aire 

The modelling carried out to support the Upper Aire SFRA tested a number of on-line flood 
storage areas (FSA). Two of these were found to lead to significant reductions in flood risk. 
These sites are Keighley Holden Park and Marley Bridge. Holden Park is the larger of these 
sites. The location of these two sites in relation to the Old Main Street study area is shown in 
Figure 2. 

Both these storage sites are upstream of the Old Main Street study area. As such these sites 
would reduce flood risk to the properties at Old Main Street. 

These two FSAs were tested for a 1-in-100 (1%) AEP flood incident and were estimated to 
reduce flood levels by 0.99m at Ireland Bridge. There are also benefits across the River Aire 
downstream with an estimated reduction in flood levels of 0.43m in Leeds City Centre.  

These FSAs have been considered primarily for their benefit in reducing risk to Leeds City 
Centre and are to be investigated as part of work for phase 2 of the Leeds FAS. However 
these will provide benefits to areas along the River Aire downstream of the FSA. 

This initial assessment considers the Old Main Street area. The FSA upstream of here would 
reduce risk to properties in this area but it will also have significant benefits beyond the study 
area. As such assessing the benefits and costs of this option are considered to be outside of 
the scope of this study and the option has not been taken forward for further assessment. 
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Figure 2: Approximate location of potential storage  sites on River Aire 
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The following options were chosen to be taken forward for assessment in conjunction with the EA 
and Bradford Metropolitan District Council (MDC).  

 
Do Nothing  

The Do Nothing option is defined as taking no action whatsoever; under this option all 
management activities would cease, including maintenance and repair work to existing assets. 

Under this assumption, natural deterioration of the channel would occur, leading to reduced 
conveyance and increased flooding. There would also be no flood warning service provided. 

The Do Nothing option is not to be taken forward as a viable option as it results in an 
unacceptable increase in flood risk to people and property due to deterioration of the channel 
and build-up of blockages. 

Do Minimum 

The Do Minimum option is defined as the minimum level of action or intervention necessary to 
sustain the standard of service (SOS) presently offered throughout the study area. It will form 
the appraisal baseline. 

This option assumes continuation of the existing maintenance regime.  This includes channel 
maintenance, operation and maintenance of weirs and other in-channel structures and where 
possible, existing non-structural measures such as flood forecasting and flood warning. 

The advantage of Do Minimum is that it sustains current standard of service within the study 
area and there are no capital costs associated with this option. The Do Minimum scenario 
does not allow for climate change. 

There are no indicators to suggest that this option is non-viable or undeliverable.   

Option 1 - Flood Walls  

This option constructs flood walls along the left bank of the river to increase the standard of 
protection. This will reduce the risk of fluvial flooding to the properties protected on this side of 
the river. There are existing third party owned walls along the river banks upstream of Ireland 
Bridge. These could be replaced by formal flood defences and raised to provide the required 
standard of protection. 

The alignment of the walls and their dimensions are a rough estimate. If this option is taken 
forward, they will have to be assessed and optimised at that stage. The design of the flood 
walls must be made to fit visually into the surrounding area and would need to consider the 
Bingley Conservation Area. Views of the river, in particular from properties, would be 
adversely impacted as would access to the river for maintenance purposes. 

Two options are considered providing different standards of protection.  

• Option 1A  providing a 1-in-100 (1%) AEP standard of protection (SOP) including 
climate change. At the start of the appraisal period the standard of protection provided 
would be expected to be higher due to the allowance for climate change. This will 
require the construction of a 1.4m high wall based on the results from the Upper Aire 
modelling report. 

• Option 1B  providing a 1-in-200 (0.5%) AEP standard of protection (SOP) including 
climate change. This will require the wall to be constructed to a greater height of 1.7m. 
As the wall height is increased it will provide a greater reduction in risk at higher cost 
and with a greater impact on the area. 
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Further modelling would be required in order to assess the impact of removal of flood plain 
due to the construction of this flood wall on communities further downstream. Compensatory 
flood plain storage may be required, adding to the costs of the scheme. It must be ensured 
that the compensatory storage is hydraulically linked to the flood plain lost, otherwise the 
benefits from it may not be fully realised. 

There may be aesthetic challenges to the scheme due to the close proximity of the walls to 
many properties. Large heights may not be viable, due to the aesthetic impact of the walls. 
There are also no environmental benefits to the scheme. Construction of the wall has the 
potential to cause temporary disruption to roads and properties.  

Option 2 - Property Level Protection 

This option is to offer property level protection (PLP) to the 16 ground floor residential 
properties identified as being at very significant risk of flooding. PLP can take the form of 
barriers in doorways, non-return valves fitted to drains, and airbrick/vent covers. Properties 
can also be made more flood resilient, using waterproof plaster, solid concrete floors or tiled 
floor coverings in order to reduce the amount of time and money needed to recover from a 
flood event. PLP is generally used as an option for properties that experience less than 
500mm of flooding. 

Advantages of this option include the fact that defences have minimal visual and land impact, 
and do not remove any of the flood plain area. PLP will also protect against surface water as 
well as fluvial flooding. Any changes would need to be in keeping with surroundings and not 
impact on the conservation area. 

Disadvantages of this option include the requirement for residents to receive sufficient alert 
and for them to be available and educated in deploying PLP measures. Alternatively passive 
PLP measures could be installed, removing the need for manual operation at times of flooding. 

PLP does not provide any wider environmental benefits and does not prevent the flooding of 
areas surrounding the property. PLP is also only possible for properties in the Very Significant 
risk band and where flooding is less than 500mm deep. This option would not prevent flooding 
during incidents of a magnitude similar to the Boxing Day 2015 flooding due to the depth of 
flooding. 

Deliverability of this option is reliant on the resident’s uptake of PLP. Some properties within 
the area have already implemented a degree of PLP.  

1.4.2 Costs of options 

The costs for the options were calculated using the Environment Agency’s Project Cost Tool 
and Long Term Costing Workbook. The maintenance and operation costs relate to mechanical 
maintenance of the assets to Target Condition 3. 

It is assumed that a major replacement of flood walls will be required 90 years after the initial 
construction phase. The timing of this is based on the EA’s Asset Deterioration Guidance 
(2013). PLP measures will require replacement every 20 years to ensure these continue to 
protect properties. 

An appraisal period of 100 years has been used. A detailed breakdown of costs across this 
period is included in Appendix B. 
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Table 1.1 shows the build-up of costs for all options.  

Table 1.1 Project costs (£k) 
Item Option 1A Option 1B Option 2 

Construction Costs *684 *830 118 

Environment Agency staff  105 127 18 

Consultant fees (appraisal)  38 47 *7 

Consultant fees (design)  132 160 23 

Consultant fees (construction) 34 42 6 

Site investigation & survey *9 *12 *2 

Land Purchase *3 *4 *0 

Optimism Bias (44%) 443 537 76 

TOTAL  1,449 1,759 250 

Annual Operation and Maintenance 
Costs 

0.638 0.638 0.611 

* These costs will need to be calculated more accurately for any future appraisal. 
 

1.5 Initial environmental assessment 

The main impacts of each option are summarised in Table 1.2: 

Table 1.2 Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Option 1A/1B Flood Walls 
Reduced risk of flooding Visual impact of wall 

 
Works adjacent to listed 
structure (Ireland Bridge). 
 
Construction work alongside 
watercourse. Risk of pollution 
incidents and disruption to area 
during construction 
 
Flood protection measures may 
impact on listed buildings and 
conservation area 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 
 
Design of wall must be sympathetic 
to character of area. 

Option 2 Property Level Protection  
Reduced risk of flooding 
including surface water 
flooding 

Flood protection measures may 
impact on listed buildings and 
conservation area 

Design of PLP measures must be 
sympathetic to character of area 

 

1.6 Consultation 

The options in this appraisal were developed in consultation with the Environment Agency and 
Bradford MDC. No public consultations were held at this stage as the work is a high-level 
assessment of potential options. Stakeholder engagement will take place at subsequent 
stages of the project. 
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1.7 Economic summary and preliminary preferred option 

Table 1.3 Benefit-cost assessment  
 PV costs  

(£k) 

PV 
benefits  

(£k) 
Av. BCR  Incr’ BCR  Option for iBCR 

calc  

Comments 

Do Nothing       

Do Minimum  18 30 1.7    

Option 2 - 
PLP 

523 742 2.8 1.4 Do Minimum 
Highest ABCR and 

IBCR 
Option 1A – 
Flood Wall 
(1in100 +CC) 

1,495 1,064 0.7 0.7 Do Minimum 
 

Option 1B – 
Flood Wall 
(1in200 +CC) 

1,811 1,136 0.6 0.6 Do Minimum 
 

Option 2 is the preferred Do Something option. This has the highest BCR of the options 
considered. Properties remain at risk with this option implemented as the PLP measures will 
not be effective during larger flood incidents with higher flood depths (>500mm) or long 
durations of flooding (>3 days). 

The Partnership Funding scores for the 3 options has been calculated as shown in Table 1.4. 
The benefit period is 90 years for Option 1A/1B and 20 years for Option 2 as after this time the 
assets require replacement and further investment would be required. The details of this 
calculation and sensitivity testing are including in Appendix F. 

Table 1.4 Benefit-cost ratios and outcome measures  

Contributions to outcome measures  
Option 1A 
Flood Wall 

(1in100 +CC 

Option 1B 
Flood Wall 

(1in200 +CC 
Option 2 – PLP 

OM1 – Economic Benefit:     

    Benefit period used for Partnership 
Funding calcs 

90 90 20 

    PV Benefits (£) 1,042,875 1,113,369 366,040 
    PV Costs (£) 1,467,160 1,777,554 258,775 
    Benefit/Cost ratio 0.71 0.63 1.41 
OM2 – No. of households moved out of any 
flood probability category to a lower category 

12 12 
16 

OM2b – No. of households for which the 
probability of flooding or coastal erosion is 
reduced from the very significant or 
significant category to the moderate or low 
category 

12 12 

16 

OM2c – No. of households in the 20% most 
deprived areas moved from the very 
significant or significant flood probability 
category to the moderate or low category  

0 0 

0 

OM4a – Hectares of water dependent habitat 
created or improved to help meet the 
objectives of the Water Framework Directive 

0 0 
0 

OM4b – Hectares of intertidal habitat created 
to help meet the objectives of the Water 
Framework Directive for areas protected 
under the EU Habitats/Birds Directive  

0 0 

0 

OM4c – Kilometres of rivers protected under 
the EU Habitats/Birds Directive improved to 

0 0 0 
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Contributions to outcome measures  
Option 1A 
Flood Wall 

(1in100 +CC 

Option 1B 
Flood Wall 

(1in200 +CC 
Option 2 – PLP 

help meet the objectives of the Water 
Framework Directive 

Partnership Funding (PF) Score  8% 7% 18% 

Contributions required for a PF score of 
100% (£) 

1,354,638 1,653,499 212,071 

Contributions required for a PF score of 
120% (£) 

1,373,000 1,674,000 
220,000 

 
1.7.1 Limitations and Uncertainties 

This initial assessment has produced a high-level appraisal of options available to manage 
flood risk in Old Main Street. There are limitations to the methodology applied and more robust 
appraisal would be required to have greater confidence in the results. 

Costs for options are based on the EA Project Costing Tool. These costs will need to be 
reviewed in more detail for any future appraisal work.  

The Weighted Annual Average Damages (WAAD) from the Multi-coloured Manual have been 
used to assess damages and hence benefits. This assesses damages based on the number 
of properties affected. This does not take into account the depths of flooding and more 
accurate damages could be calculated if information on expected flood depths was available. 

The WAAD methodology is unsuitable for assessing the impacts of climate change. Defences 
have been assessed as provided a constant standard of protection throughout the appraisal 
period. Options accounting for climate change will provide a higher standard of protection early 
in the appraisal period and will therefore have greater benefits than those assessed. 

1.7.2 Funding and contributions 

A funding analysis tool was used to identify potential direct and indirect beneficiaries of the 
scheme. This is included in Appendix E. Based on these beneficiaries potential funding 
sources identified include: 

• Community Infrastructure Levy 

• Council Tax 

• Local Enterprise Partnerships 

1.7.3 Key delivery risks (economic, social and environmen tal) 
Key delivery risk and recommendations for mitigating these risks are shown in the table 
below. 

Table 1.5 Risks and mitigation  

Risk Key Mitigation 

Effectiveness of PLP limited by Flood warning 
time 

Flood warnings should continue to be 
reviewed to ensure suitable lead time is 
available to deploy PLP.  
 
Alternatively passive PLP measures could 
be specified removing the requirement for 
flood warning. 

Insufficient third party Funding available to allow 
scheme to progress 

Assess potential funding options before 
progressing scheme appraisal further. 
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Risk Key Mitigation 

Properties at risk already have PLP measures 
installed reducing the effectiveness of additional 
measures 

Review level of protection provided by 
PLP that is currently installed within the 
area and adjust costs and benefits to 
reflect this 

1.8 Project Scoring 

The data used in this assessment has been subjected to a RAG assessment. The RAG score 
assesses the project against the categories shown below. This gives a three figure score with the 
first number being the number of reds, where there is significant uncertainty or challenges. The 
second and third numbers are the numbers of amber(defined as needs development, but is 
manageable) and green(well defined, not likely to be an issue) scores. The results are shown 
below: 

• A – Problem Definition: The fluvial flooding is well defined with flood outlines but 
further investigation is required to understand the surface water flooding mechanisms 
– AMBER  

• B – Economic: There are limitations to the methodology applied and more robust 
appraisal would be required to have greater confidence – RED: 

• C – Funding:  The options are likely to require external funding. Potential funding 
sources have been identified – AMBER  

• D – Engineering case: Preferred solutions are tried and tested defence options – 
AMBER  

• E – Permissions & Consents: Solutions are unlikely to require unusual permissions or 
consents – GREEN 

• F – Environmental sensitivities: Initial environmental assessments has been 
completed based on outline options, some impact from options requiring work close to 
river – AMBER  

• G – Opportunities: Some potential opportunities for partnership working – AMBER  

Model 

A 

Economic 

B 

Funding 

C 

Eng. 

D 

Permissions 

E 

Env. 

F 
RAG 

Opps. 

G 

2 3 2 2 1 2 141 2 

 

1.9 Further work requirements 

If the project is taken forward for further appraisal it is recommended that the following work is 
carried out to improve confidence in this economic assessment: 

• Assessment of depths of flooding in Old Main Street should be carried out through 
hydraulic modelling. This would allow more accurate assessment of damages and the 
effectiveness of PLP to be carried out. A review of the existing models would allow the 
results from these to be used to provide a more accurate damages assessment. This 
review is currently being undertaken. 

• The extent of existing PLP measures installed within the area should be assessed to 
determine if further PLP can be practically implemented. 
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• Surface water flood risk in the area should also be assessed further and measures to 
reduce this considered. In particular the overland flow down Altar Lane observed 
during the Boxing Day flood should be addressed to prevent flooding from this source. 

• The potential storage areas identified on the River Aire in the Upper Aire SFRA should 
be assessed further. This assessment should include the benefits to Bingley and to 
other sites along the River Aire. Previous assessment investigating flood storage at 
Holden Park and Marley Bridge estimated this would reduce flood levels at Ireland 
Bridge by 0.99m. This would significantly reduce the need for a scheme at Old Main 
Street and may provide a viable solution to provide a higher standard of protection. 

 

1.10 Conclusions and Recommendations 

• Properties at Old Main Street are at high risk of flooding from the River Aire. The main risk 
of flooding is fluvial from the River Aire overtopping its banks. There was significant 
flooding in the area during Boxing Day 2015. 

• Flooding during the Boxing Day 2015 incident was exacerbated by flood warnings arriving 
after the onset of flooding to several properties. These warnings have since been 
reviewed and updated. This will reduce the damage of future events and increase the 
effectiveness of PLP measures including those already installed in the area 

• The preferred option for managing this flood risk is Property Level Protection. With PLP 
measures in place the area will remain at risk from larger flood incidents. It is not seen to 
be economically viable to construct defences at this location. 

• The Preferred option does not remove risk of flooding during large flood incidents and 
additional work will be required to fully address flooding to this area. This site would 
remain at risk from severe incidents such as the Boxing Day 2015 flooding. 

• There are a number of properties in the study area at high risk of flooding. As such there 
is a high economic benefit from providing a relatively low standard of protection.  
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